Trademark Information

ASD Inc.
2555 55th Street
Boulder, CO 80301 USA
Phone: (303) 444-6522
www.asdi.com

FieldSpec®, LabSpec®, QualitySpec®, TerraSpec®, AgriSpec®, RxSpec®, ViewSpec™, RS3™, Indico™, and goLab™ are registered, and unregistered trademarks, and the intellectual property of ASD Inc. All trademarks used or displayed in this document are the property of ASD, its affiliates, or third party owners. Unauthorized use of these trademarks is illegal and punishable by law. Nothing contained in this document is to be construed as granting, by implication, estoppel, or otherwise, any license or right of use of any such trademark without the prior and express written permission of ASD, or such third party owner.

This document contains proprietary information protected by copyright law and may not be reproduced in any manner without the express written approval of ASD Inc.

The information and specifications contained in this manual are subject to change without notice. ASD Inc. shall not be held liable for technical, editorial omissions, or errors made herein; nor for incidental or consequential damages resulting from furnishing, performance, or use of this material.

Technical Support

If you have any questions or concerns, please contact ASD Inc. by phone, fax, or email:

Phone: 303-444-6522 X-144
Fax: 303-444-6825
company: support@asdi.com
Web: www.asdi.com
ftp: ftp.asdi.com

Technical support is committed to providing you with a timely response to your questions. We will work with you to provide solutions to your applications. Technical support is available to answer your questions Monday thru Friday, 8 am to 5 pm Mountain Standard Time. We will happily respond to your e-mail queries as well.
# Table of Contents

**Trademark Information** ................................................................. ii
**Technical Support** ................................................................. ii

**Declaration of Conformity** ......................................................... vii

**Chapter 1 Introduction** ............................................................... 1
  - Hardware Specifications ......................................................... 2
  - Physical Specifications ......................................................... 2
  - Power Input and Output ........................................................ 2
  - TerraSpec Wavelength Configuration .......................................... 3
  - Interface Requirement .......................................................... 4
  - Standard Accessories ........................................................... 4
  - Computer Requirements .......................................................... 5
  - Software Requirement ............................................................ 5
  - Theory of Operation .............................................................. 6

**Chapter 2 Setup** ........................................................................ 11
  - Unpacking the Instrument ....................................................... 12
  - Power Supply ........................................................................... 13
  - Ethernet Cables ....................................................................... 15
  - Accessory Power Port .............................................................. 16
  - Remote Trigger ........................................................................ 17

**Chapter 3 Usage and Maintenance** ............................................... 19
  - Light Sources ........................................................................... 19
  - Access and Ventilation ............................................................... 19
  - Cleaning .................................................................................... 20
  - Annual Maintenance ................................................................... 20
  - Returning Instrument to ASD for Service ..................................... 20

**Chapter 4 Fiber Optic Interface** .................................................. 21
  - Fiber Optic Cables ..................................................................... 21
  - Fiber Optic Cable Interface ........................................................ 22
  - Matching Fiber Bundles ............................................................... 24
  - LED Check for Fiber Optic Cable ............................................... 26
# Chapter 5 Batteries
- Battery Care ................................................. 31
- Battery Charger .......................................... 32
- Application Battery Indicator ......................... 33

# Chapter 6 Field Measurements
- Illumination .................................................. 36
- Rocks, Soils, and Man-Made Materials ............... 36
- Suggested Set-up ........................................... 36
  - RS3 Application ........................................ 36
  - Indico Application ................................... 37
- White Reference ............................................ 38
  - Spectralon Reflectance Data ......................... 39
  - Maintaining Spectralon References ................. 40
- White Reference Procedures ............................ 41

# Appendix A Troubleshooting
- Common Communication Fixes ......................... 43
  - Does Not Connect to the Spectrometer ............ 43
  - Does Not Connect Wireless ......................... 45
  - Does Not Connect to the Access Point .......... 46
  - Spectrometer Loses its Wireless Connection .... 47
  - Wireless Interface is Disabled in the Netcfg Application .... 47

# Appendix B Reference Information
- Frequently Asked Questions (FAQ) ................. 49
  - What is a spectrometer? ............................... 49
  - What are the differences between the ASD spectrometers? ... 50
  - What is remote sensing? ............................. 50
  - How often do I need to optimize? ................ 51
  - How often do I need a (baseline) White Reference? 51
  - What spectrum average (or sample count) should I use? 51
  - What if I want to keep the same settings all day? 51
  - What are the units of radiance? .................... 52
  - Can I post-process my data? ....................... 52
  - Why do I see oscillations (sine wave) in my data? 52
  - What are these upward or downward spikes in VNIR data? 52
  - What are these steps in my data? .................. 53
  - What can cause more noise in my data from last time? 53
## Declaration of Conformity

**Manufacturers Name:** Analytical Spectral Devices, Incorporated.

**Manufacturers Address:** 5335 Sterling Drive, Suite A  
Boulder, CO  80301  
Phone: (303) 444 6522

**European Contact:** Your local Analytical Spectral Devices Representative.

Declares that the product(s)

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Description</th>
<th>Range (nm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A100800</td>
<td>SWIR1 &amp; SWIR2 High Resolution</td>
<td>1000-2500</td>
</tr>
<tr>
<td>A100810</td>
<td>Full Range (VNIR, SWIR1, &amp; SWIR2) High Resolution</td>
<td>350-2500</td>
</tr>
<tr>
<td>A100820</td>
<td>SWIR2 only</td>
<td>1800-2500</td>
</tr>
</tbody>
</table>

Conforms to the following EU Directives:


**Supplementary Information:**

The product complies with the requirements of the following Harmonized Product Standards and carries the CE-Marking accordingly:

- **EN 61010-1: 2001** Safety Requirements for Electrical Equipment for Measurement, Control and Laboratory use
- **EN 61326-1: 2002** Class A, Electrical Equipment for Measurement, control and Laboratory use – EMC requirements

**Signature:**

**Title:** Director of Engineering

**Date:** 11/02/2005
Symbols - Definitions

**CAUTION: Risk of Danger.** This is a personal danger warning. Documentation must be consulted in all cases where this symbol is marked. Failure to acknowledge these warnings could result in personal injury to the user.

**CAUTION: Risk of Electric Shock.** This is a personal danger warning. Documentation must be consulted in all cases where this symbol is marked. Failure to acknowledge these warnings could result in personal injury to the user.

**CAUTION: Hot Surface.** This is a personal danger warning. Documentation must be consulted in all cases where this symbol is marked. Failure to acknowledge these warnings could result in personal injury to the user.

**Recycle.** Items with this symbol indicate that the item should be recycled and not disposed of as general waste.

Warnings and cautions are placed throughout this manual for the convenience of the reader. However, the absence of warnings and cautions do not preclude the user of proper caution and handling. Usual precautions are recommended to be taken at all times, either written or otherwise, to avoid personal injury or damage to ASD equipment.
The Power Supply is intended for Indoor Use Only

When using an electrical appliance, basic safety precautions should always be followed.

Danger- To reduce the risk of electric shock read all instructions before using the power supply. A power supply should never be left unattended when plugged in. Always unplug the power supply from the mains socket immediately after using.

Warning- To reduce risk of burns, fire, electric shock or injury to persons or animals:

1. Use this power supply only for its intended use as described below.
2. Do not use outdoors.
3. Do not allow to be used as a toy. Pay close attention when this power supply is used by, or near to, children.
4. Use only attachments recommended by the manufacturer.
5. Never operate the power supply if it has a damaged cord or plug, if it has been dropped or damaged or if it has fallen into water. In such cases return the power supply to an authorized dealer or service center for examination or repair.
6. Never drop or insert an object into any openings.
7. Do not operate where aerosol (spray) products are being used or where oxygen is being administered.
8. The power supply should be used near to a convenient and easily accessible mains socket.
Chapter 1  Introduction

The TerraSpec spectrometer is a high-resolution instrument that measures the visible near-infrared (VNIR) and short-wave infrared (SWIR) spectra for geologic remote sensing and analysis.

The TerraSpec spectrometer is specially designed for mining and geology applications. It is ideally suited for performing reflectance and transmittance spectral measurements of rocks, minerals, and core samples. Its higher resolution is optimized for identification of minerals associated with economic ore deposits.

The ASD Accessories Guide contains an array of devices to extend the application areas for the spectrometer, the Hi-Brite MugLite and Hi-Brite Contact Probe are specifically designed to work with this high resolution instrument.

The TerraSpec spectrometer is compact and field portable. It has a spectral range of 350-2500 nm and rapid data collection (10 spectra per second).

While its most highly regarded features are performance and field-portability, these instruments perform competitively in the laboratory as well.

Features and Advantages

**Accurate and Precise** - high resolution and superior repeatability of results for better discrimination and analysis of materials.

**Rugged and Transportable** - Resistant to vibration and changes in temperature or humidity.

**Fast** - 10 spectra per second data collection for the entire 350-2500 nm range.
  » 0.1 second scanning time provides an accurate average every second
  » Users can quickly scan several areas when analyzing bulk samples.
  » Rapid analysis allows screening all or most samples versus spot checking.

**Compatible** - Works with off-the-shelf mineral spectrum analysis software available from SII and chemometrics software (such as Grams™ PLS plus/IQ and Unscrambler®).
1.1 Hardware Specifications

This section contains details about the TerraSpec spectrometer.

1.1.1 Physical Specifications

<table>
<thead>
<tr>
<th></th>
<th>Height</th>
<th>12.7 cm</th>
<th>5 inches</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Width</td>
<td>35.6 cm</td>
<td>14.5 inches</td>
</tr>
<tr>
<td></td>
<td>Depth</td>
<td>29.2 cm</td>
<td>11.5 inches</td>
</tr>
<tr>
<td></td>
<td>Weight</td>
<td>5.6 kg</td>
<td>12 lbs</td>
</tr>
</tbody>
</table>

- Durable satin powder coat finish with orange urethane end-caps and handles
- All vital components are in a dust-proof enclosure and EMI sealed
- Adjustable fiber optic to instrument spacer

1.1.2 Power Input and Output

<table>
<thead>
<tr>
<th></th>
<th>AC Power Supply Type</th>
<th>Auto ranging, Switching, SELV</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC Input</td>
<td>90-240 VAC, 50/60 Hz</td>
<td></td>
</tr>
<tr>
<td>DC Input</td>
<td>+12 VDC, 60 W</td>
<td></td>
</tr>
<tr>
<td>Accessory Power Port (front of instrument)</td>
<td>Output, +12 VDC, 19.2 W (max).</td>
<td></td>
</tr>
</tbody>
</table>
1.1.3 TerraSpec Wavelength Configuration

<table>
<thead>
<tr>
<th>Wavelength Name</th>
<th>Wavelength Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>VNIR-SWIR1-SWIR2</td>
<td>350-2500 nm</td>
</tr>
<tr>
<td>SWIR1-SWIR2</td>
<td>1000-2500 nm</td>
</tr>
<tr>
<td>SWIR2 only</td>
<td>1800-2500 nm</td>
</tr>
</tbody>
</table>

The near infrared (NIR) is also called the short-wave infrared (SWIR).

The spectral resolution is:

- 3 nm (Full-Width-Half-Maximum) at 700 nm.
- 6 nm (Full-Width-Half-Maximum) at 1400 nm.
- 6 nm (Full-Width-Half-Maximum) at 2100 nm.

The sampling interval is:

- 1.4 nm for the spectral region 350-1000 nm.
- 2 nm for the spectral region 1000-2500 nm.

The TerraSpec spectrometer may be configured to have three separate holographic diffraction gratings with three separate detectors. Each detector is also covered with the appropriate order separation filters to eliminate second and higher order light.

- VNIR: 512 element silicon photo-diode array for the spectral region 350-1000 nm.
- SWIR1: graded index, TE-cooled, extended range, InGaAs, photo-diode for the spectral region 1000 nm to 1800 nm.
- SWIR2: graded index, TE-cooled, extended range, InGaAs, photo-diode for the spectral region 1800 nm to 2500 nm.
1.1.4 Interface Requirement

The TerraSpec spectrometer has 10/100 Base T Ethernet port. The spectrometer with an Ethernet cross-over cable can be directly connected to the Ethernet port provided on many laptop computers.

The TerraSpec spectrometer can communicate with the instrument controller using an optional 802.11b wireless card. If the instrument controller is supplied by the customer, it must be 802.11b compatible.

The TerraSpec spectrometer uses industry standard components. The instrument controller has the same general connection speed and distance capabilities as other 802.11b wireless devices.

For the best performance, ensure a clear line-of-sight between the spectrometer and instrument controller. Obstructions or radio frequency interference in close proximity can cause loss of communication or significantly shorten the communication range.

Note: For information about configuration of the Ethernet card and cable, please refer to the Installation Manual.

1.1.5 Standard Accessories

- TerraSpec® Spectrometer
- TerraSpec® User Manual (PDF on Flash Drive)
- Instrument Controller: ASD-approved laptop computer
- RS3 Software Pack
- 1.5 meter FR Low OH Fiber Optic Jumper Cable
- Power Supply 12 V
- Battery Belt, Gel Cell (12 V, 9 A hour) with Charger and 6 ft. Battery-to-Instrument Power Cable
- Power Adapter with 6 m (20 ft) Cable for Automobile Cigarette Lighter (When using this adapter, turn off the engine to the vehicle, electromagnetic fields from the engine can generate noise in the acquired signals.)
- 1.5 meter Instrument-to-Probe Accessory Power Cable
- Remote Trigger with LEDs and Velcro Pads
- RJ45 CAT 5e UTP Ethernet, Shielded, Crossover Cable
- 64 MB (min.) Flash Drive Memory USB Flash Drive
- Mylar Wavelength Reference
- Shipping Trunk: Durable, air tight, wheeled, fold down handle, and foam filled with cutouts to protect the instrument and many accessories
1.2 Computer Requirements

The *instrument controller* is a computer that manages the TerraSpec spectrometer, stores data, and processes the results.

The standard TerraSpec spectrometer includes a laptop computer, or the *instrument controller*.

The minimum requirements for the instrument controller are:

- 1.2 GHz Pentium or better notebook or PC-w/monitor
- 256 MB RAM or more
- 20 GB of free disk space
- 1024 x 768 or better graphics resolution
- 24-bit color or better - 32-bit recommended
- Ethernet port: 10/100 Base T Ethernet interface
- (Optional) Ethernet wireless (WiFi) adaptor: PCMIA, USB, or built-in that is compatible with the 802.11b standard
- (Optional) Serial communications port (or USB port) for GPS receiver. (only required when GPS is used)
- (Optional) NMEA compatible GPS receiver

1.3 Software Requirement

The instrument controller requires the following software:

- RS³ Software from ASD
- Microsoft Windows® 95/98/NT/2000/ME/XP Operating System
- Microsoft Internet Explorer 6.0 or better

Users need a basic understanding of the Microsoft Windows operating system including software installation.

International customers using non-English versions of Windows must alter the Regional Settings under Start->Settings->Control Panel. The default language must be set to English (United States) in order for the software to be registered and operate correctly. The numbering format must also be set to English.
1.4 Theory of Operation

The TerraSpec spectrometer measures the optical energy that is reflected by, absorbed into, or transmitted through a sample. Optical energy refers to a wavelength range that is greater than just the visible wavelengths, and is sometimes called electromagnetic radiation or optical radiation.

With accessories, various set-ups, and built-in processing of the optical energy signal, the TerraSpec spectrometer can measure:

- spectral reflectance,
- spectral transmittance, and
- spectral absorbance.

Fiber Optic Collection of Reflected/Transmitted Light

Optical energy is collected through a bundle of specially formulated optical fibers, precisely cut, polished, and sealed for extremely efficient energy collection. The fibers themselves are of low OH composition providing the maximum transmission available across the instrument's wavelength range.

Inside the TerraSpec® Spectrometer

The fiber cable delivers the collected optical energy into the instrument, where it is projected onto a holographic diffraction grating. The grating separates and reflects the wavelength components for independent measurement by the detectors.

Visible/Near-Infrared (VNIR)

The Visible/Near-Infrared (VNIR: 350-1000 nm wavelength) portion of the spectrum is measured by a 512-channel silicon photodiode array overlaid with an order separation filter. Each channel (or detector) is geometrically positioned to receive light within a narrow (1.4 nm) range. The VNIR spectrometer has a spectral resolution (full-width half maximum of a single emission line) of approximately 3 nm at around 700 nm.

Each detector converts incident photons into electrons. This photocurrent is continually converted to a voltage and is then periodically digitized by a 16-bit analog-to-digital (A/D) converter. This digitized spectral data is then transmitted to the instrument controller for further processing and analysis by the controlling software.

The 512-channel array permits the entire VNIR spectrum to be scanned in parallel at 1.4 nm wavelength intervals. A single sample can be acquired in as little as 17 ms.
Short-Wave Infrared (SWIR)

The Near-Infrared (NIR), also called Short-Wave Infrared (SWIR), portion of the spectrum is acquired with two scanning spectrometers:

- SWIR1 for the wavelength range of 1000 nm to 1800 nm.
- SWIR2 for the wavelength range of 1800 nm to 2500 nm.

The SWIR scanning spectrometers only have one detector for SWIR1 and another for SWIR2. This is different from the VNIR spectrometer, which has an array of 512 detectors. Thus, SWIR spectrometers collect wavelength information sequentially rather than in parallel.

Each SWIR spectrometer consists of a concave holographic grating and a single thermo-electrically cooled Indium Gallium Arsenide (InGaAs) detector. The gratings are mounted about a common shaft which oscillates back and forth through a 15 degree swing. As the grating moves, it exposes the SWIR1 and SWIR2 detectors to different wavelengths of optical energy. Each SWIR spectrometer has ~600 channels, or ~2 nm sampling interval per SWIR channel. The spectrometer firmware automatically compensates for the overlap in wavelength intervals.

Like the VNIR detectors, the SWIR1 and SWIR2 detectors convert incident photons into electrons. This photocurrent is continually converted to a voltage and is then periodically digitized by a 16-bit analog-to-digital (A/D) converter. This digitized spectral data is then transmitted to the instrument controller for further processing and analysis by the controlling software.

The grating is physically oscillating with a period of 200 ms. It performs a forward scan and a backward scan, resulting in 100 ms per scan. This is the minimum time required for any SWIR samples, or full-range samples.

Communicating with the Instrument Controller (Computer)

The TerraSpec spectrometer communicates with the instrument controller using a cross-over Ethernet cable or optional Wireless Ethernet (WiFi) interface. The amount of data that is sent depends on the configuration of the spectrometer.

- A single sample of VNIR is ~1024 bytes.
- A single sample of SWIR1 is ~2400 bytes.
- A single sample of SWIR2 is ~2400 bytes.

A full-range TerraSpec spectrometer can create packet data sizes over 5 KB. Other single or dual range configurations of the spectrometer create smaller data packets (adding the packet sizes as above.)

When features for spectrum averaging (or sample count) are turned on within the application software on the instrument controller, the averaging is performed at the spectrometer.
Dark Current Measurement

*Dark Current* (DC) refers to current generated within a detector in the absence of any external photons. DC is the amount of electrical current that is inherent in the spectrometer’s detectors and other electrical components and is additive to the signal generated by the measured external optical radiation.

**Note:** *Noise* is the uncertainty in a given measurement, one channel at a time. Noise by definition is random. Noise can be reduced by using more samples and averaging the signal. *Dark Current* is different from noise, because it is relatively stable and can be characterized.

This manual uses DC to refer to all systematic contributions to the detector’s signal. DC is a property of the detector and the associated electronics (not the light source). DC varies with temperature. In the VNIR region, DC also varies with integration time.

Whenever DC is taken, a mechanical shutter is used to block off the entrance slit of the VNIR spectrometer so the signal can be measured. This signal is subtracted from each subsequent spectrum until another DC is taken. The SWIR spectrometers take and subtract DC on every scan.

The DC measurement can be updated at any time, but should be updated more frequently in the beginning of a given session while the instrument warms up.

The VNIR spectrometer is fitted with a unique software and hardware combination feature called *Driftlock*. Driftlock corrects for DC changes over time. It automatically updates DC for every measurement by looking at a series of masked pixels at the front portion of the VNIR array. The Driftlock feature corrects for the majority of DC variation over time.

White Reference

A material with approximately 100% reflectance across the entire spectrum is called a white *reference panel* or white *reference standard*.

The raw measurement made by the spectrometer is influenced by both the sample and the light source. An independent measure of the light source illumination on a reference of known reflectance is required to calculate the reflectance of the sample. The use of a white reference standard with near 100% reflectance simplifies this calculation.

Reflectance and transmittance are inherent properties of all materials and are independent of the light source.

*Reflectance* is the ratio of energy reflected from a sample to the energy incident on the sample. *Spectral Reflectance* is the reflectance as a function of wavelength.

*Transmittance* is the ratio of the radiant energy transmitted through a sample to the radiant energy incident on the surface of the sample. *Spectral Transmittance* is the transmittance as a function of wavelength.
Relative reflectance is computed by dividing the energy reflected from the sample by the energy reflected off a white reference panel or standard.

Accessories for Light Sources and Probes

ASD offers several accessories for:

- Delivering illumination to the sample
- Collecting reflected or transmitted light from the sample
- Transmitting the collected light to the spectrometer

Some accessories, such as the Hi-Brite Contact Probe, perform all of these functions. Other accessories, such as some of the optional foreoptic probes, rely on other illumination sources.

Accurate analysis of collected spectra requires an adequate level of incident light on the sample. The Hi-Brite Contact Probe accessory is designed for stability and accuracy and provides a controlled source of incident light having a color temperature of 3,000°K. The probe is powered by the accessory power port of the TerraSpec spectrometer. Characteristics of the light source are eliminated when the white reference (or baseline spectrum) is applied to each raw sample spectrum.
Chapter 2  Setup

Inspect the shipping container and take careful notes regarding any damage that might have occurred during shipping.

Note: Save all packing materials, foam spacers, and paperwork for possible future use.

Prepare a clear space on a sturdy bench or counter, ideally, a space near a wall-current receptacle and the controlling computer.

Carefully open the shipping container following all instructions and orientation labels on the container.

Figure 2-1  TerraSpec spectrometer in carrying case.
2.1 Unpacking the Instrument

Step 1 Carefully remove the instrument from its shipping case.

Note: During operation, the unit will work correctly regardless of the physical orientation, such as sideways in a specially designed Ergonomic Pro-Pack.

Step 2 The computer is located directly below the instrument between the foam inserts.

Step 3 Under the computer compartment, there is a circular cut-out. Carefully remove the fiber-optic cable located below the foam insert at the bottom of the case.

The remaining portion of the case is designed to hold the various accessories that may have been purchased with the instrument. There are specific locations for the Contact Probe, Hi-Bright Muglite, Spectralon, battery pack, and miscellaneous power cables.

WARNING! The fiber cable should never be stored with a bend of less than a 5" diameter for long periods of time, because the cable can be damaged with undetectable longitudinal fractures that can cause light leakage and weaker signals.
2.2 Power Supply

The TerraSpec spectrometer requires input power to be 12 VDC (60 W). It does not contain an internal power supply to convert AC voltage to DC, nor does it have internal batteries.

The options for providing the spectrometer with the appropriate DC voltage are:

- An external power supply that converts 100 VAC to 240 VAC (50 Hz or 60 Hz) to 12 VDC (shown in Figure 2-3).
- An external battery pack that delivers 12 VDC.

**Caution!** Use only ASD approved power supplies or connectors to power the instrument.
Both the external AC power supply and the DC battery pack have the appropriate power connector (Figure 2-5) to connect to the TerraSpec spectrometer on the back panel (Figure 2-6).

Insert power (battery or power supply) into the receptacle on the back panel labeled “INPUT 12 VDC 50 WATT”. Lock the connector in place by twisting the barrel end of the connector clockwise.
2.3 Ethernet Cables

For Information about configuration of the Ethernet card and cable please refer to the Installation Guide. Only use shielded Ethernet cables to reduce electromagnetic interference with the instrument.

Note the location of the computer interface connection. Figure 2-6 shows the back panel containing the Ethernet port, which is labeled “RJ45/ETHERNET”.

With the TerraSpec spectrometer and the instrument controller fully powered-down and turned-off, plug the shielded cross-over Ethernet computer cable (as shown in Figure 2-7) into the Ethernet ports of the TerraSpec spectrometer and your instrument controller.
2.4 Accessory Power Port

The accessory power port is located on the front of the unit, as is shown in Figure 2-8. This port is where external accessories, such as the Contact Probe or Source Probe, attach to receive power from the spectrometer.

The accessory power port is provided for optional ASD approved accessories. Attach the large connector end of the cable into the accessory power port of the front panel. Attach the other end of the power cable into the Contact Probe, Hi-Brite MugLite, or other ASD approved accessory.
Please contact ASD for information about these accessories.

**WARNING!** Never attempt to use unauthorized accessories on the accessory power port

![Cable used from the TerraSpec spectrometer accessory power port to the Contact Probe, MugLite, or other authorized ASD accessory.](image)

**Figure 2-9** Cable used from the TerraSpec spectrometer accessory power port to the Contact Probe, MugLite, or other authorized ASD accessory.

### 2.5 Remote Trigger

An external trigger is standard with the TerraSpec spectrometer.

The LEDs on the trigger are bright enough to be seen even on a sunny day. The LEDs are light up when the trigger is pushed (briefly) and turn off when the capture is complete. **Figure 2-10** shows the trigger switch with its LEDs.

The trigger plugs into the spectrometer near the fiber optic cable, as is shown in **Figure 2-11**.

![External trigger.](image)

**Figure 2-10** External trigger.
The trigger comes with several pieces of mated velcro, that are intended for use with several accessories. Place a piece of hook velcro onto the trigger; place pieces of mesh velcro onto the accessories.

Note: Accessories should have pieces of mesh velcro placed on both sides so that the trigger can be used right- or left-handed.
Chapter 3 Usage and Maintenance

For personal safety and to prevent damage to the instrument, please review the following safety precautions. All operators should be familiar with this information.

3.1 Light Sources

Use only light sources supplied by ASD Inc. Light sources supplied by ASD are designed to provide levels of illumination and stability of output that complement the performance of ASD instrumentation.

- Never touch the light source bulb and avoid contact with hot metal components near the bulb! Heat transfer from the light source may make these metal components uncomfortably warm to the touch.
- Prevent dirt and oils from contacting the bulb and reflector.
- Do not touch the glass envelope of the bulb. Oils on the hand may transfer to the glass envelope, which can significantly affect the bulb temperature and corrupt important operating physics of the bulb.

Note: Please refer to the ASD Accessories Manual or the instructions for that specific accessory for detailed information.

3.2 Access and Ventilation

When used inside, provide adequate room ventilation for the spectrometer. Insufficient ventilation can result in overheating of the spectrometer and subsequently corrupted data and possibly physical damage to the spectrometer.

⚠️ Do not cover the vents of the instrument.

Do not place objects on the unit or its power supplies. Prevent objects from obstructing ventilation slits.

Keep objects and spills from entering or falling onto the instrument, power supplies, and software disks.
3.3 Cleaning

Step 1  Turn off the unit.
Step 2  Disconnect from all power.
Step 3  Allow the unit to cool down.
Step 4  Clean unit with a slightly damp cloth and mild soap.

Note: Be sure all soap residue is removed and all surfaces are dry before use.

3.4 Annual Maintenance

ASD recommends that the instrument be serviced once a year. This will ensure the proper function of the instrument. Annual maintenance is covered under ASD's warranty or the extended service contract. Annual maintenance can be purchased separately. If you are interested in purchasing annual maintenance or an extended service contract, please contact your sales representative.

3.5 Returning Instrument to ASD for Service

In order to return the instrument to ASD for maintenance or repair, a Return Merchandise Authorization (RMA) must be issued by ASD technical support. The RMA includes scheduling details, contact information, shipping instructions, as well as a brief description of the maintenance or repair requirements. Please contact the technical support department at 303-444-6522 x-144 or support@asdi.com.
Chapter 4  Fiber Optic Interface

ASD offers a variety of fiber optic cable lengths to interface with the TerraSpec spectrometer. These fiber optic cables are used for reflectance and transmittance measurements.

Fiber optic cables should be loosely coiled and stored in the compartments provided. All accessories should be stored in the designated compartments of the carrier or in a separate protective case.

4.1  Fiber Optic Cables

Two fiber optic cables are included with the spectrometer: an external cable and an internal cable (built into the instrument).

• For high resolution spectrometers the internal fiberoptic cable is made up of thirty-seven (37) randomly distributed, ultra low-OH, silica glass fibers. Nineteen (19) of these fibers are 100 micron and are distributed to the VNIR region. The remaining eighteen (18) fibers are 200 micron and are evenly divided between the two SWIR regions (9 SWIR1 fibers and 9 SWIR2 fibers)

• The external fiber optic cable is made up of forty-four (44) randomly distributed, ultra low-OH, silica glass fibers that are 200 micron. This cable has a Numerical Aperture (NA) of 0.22.

The external fiber optic cable length is typically 1.5 meters. Additional external fiber optic cables can be ordered in a variety of lengths. However, as the length increases, the cable’s transmission decreases at wavelengths below 400 nm and above 2000 nm.

External fiber optic cables should be coiled and stored in the compartment provided in the shipping case. All accessories should be stored in the designated compartment of the case or in a separate protective case.
The external fiber optic cable protects the fibers with a metal spiral inside the black PVC cable casing. If there are kinks in the cable, the fibers are not necessarily damaged. If, however, the cable has been damaged so severely that the protective metal spiral can be seen, the chances are high that the fibers have been damaged. Each broken fiber results in a ~5% loss of response.

**WARNING!** The fiber optic cable should never be stored with a bend of less than a 5" diameter for long periods of time.

The fibers can be damaged by coiling the cable up too tightly. If left in a tight coil for longer than a week, the fibers are likely to develop longitudinal fractures that will not be detectable. These fractures in the fiber will cause light leakage, resulting in a weaker signal. The fiber optic cables should be stored by placing them loosely within an appropriate compartment of the carrying case or in their own protective case.

**Tips on care for the fiber optic cable:**

- Do not pull or hang the spectrometer by the fiber optic cable.
- Do not use wires, ties, or clamps to tightly attach the fiber optic cable to objects, these might pinch or penetrate the protective jacket thereby damaging the fibers inside.
- Avoid whipping the fiber optic cable, dropping it, or slamming it into objects, this can cause fractures to the glass fibers.
- Avoid twisting the fiber optic cable, because such forces may cause fractures to fibers.

While the tip of the fiber optic cable is not particularly susceptible to damage, a tip cover is recommended to protect against abrasion and exposure to contamination. Replacement covers can be made by cutting pieces of eighth-inch shrink tubing to about 1.5" lengths and shrinking them onto the fiber cable tip. The covers will slide on and off the cable easily.

### 4.2 Fiber Optic Cable Interface

All fiber optic cables come with a standard SMA style 905 connector, as shown in Figure 4-1.
In order to achieve the best response from ASD instruments it may be necessary to adjust the fiber optic interface between the external fiber optic cable (shown in Figure 4-2 and Figure 4-3) and the instrument connection.

Note: The fiber optic bundle matcher has a standard 1.7 mm fiber optic bundle input.
ASD external fiber optic cables most commonly come in one of the configurations listed in Figure 4-4. The millimeter size (mm) is the internal diameter of the fiber optic bundle.

The TerraSpec spectrometer comes with the 1.7 mm external fiber optic cable diameter.

4.3 Matching Fiber Bundles

There should now be an understanding of how the external fiber optic cables and the fixed fiber optic bundle matcher are configured, they now need to be combined. The three scenarios in Figure 4-5 show how the fiber optic bundles are matched.
All external fiber optic bundles on the TerraSpec spectrometer are full (i.e., 1.7 mm diameter) bundles. They are used with the matcher fully threaded into the body. Periodically remove the matcher to clean the internal fiber optic tip.

Note: The optimal setting for this fiber optic bundle matcher is adjusted at the ASD factory. If the customer has ordered several fiber optic configurations, it may be necessary to adjust this bundle matcher in order to achieve the highest signal to noise ratio and best instrument response. Changing the bundle matcher can effect the performance of the spectrometer.

**In order to match the bundles:**

1. Unlock the hex-nut bolt at the front of the bundle matcher on the spectrometer with the 3/8 inch hex-nut driver (included with your instrument.)

2. The TerraSpec spectrometer should be set up with the adjustment barrel of the matcher fully threaded into the body of the matcher any time a full 1.7 mm bundle is used (this is almost always).

3. With the ASD software application (RS3 or Indico) running and the fiber optic cables attached, hand screw the fiber optic bundle matcher until the optimal signal is achieved. *Do not over twist the fiber optic bundle!*

   The optimal signal will be achieved by watching the RAW DN (DN = digital numbers) in the ASD application as the fiber optic bundle matcher is being hand adjusted.

   Note: The TerraSpec spectrometer should be set up with the adjustment barrel of the matcher fully threaded into the body of the matcher any time a full 1.7 mm bundle is used.

4. Once the optimal signal is achieved, lock down the fiber optic bundle matcher. Tighten the 3/8 hex-nut by turning the wing nut against the face of the instrument. Use the hex wrench to hold the 3/8 hex-nut in place while you tighten the wing nut.
When the bundle matcher is removed, it may be a good time to clean the fiber optic cable and the exposed fiber optic on the spectrometer. This can be done by using de-ionized water, cleaning the end, and then gently wiping the excess off. You can also use canned air to blow off any dust that may have accumulated.

4.4 LED Check for Fiber Optic Cable

The TerraSpec spectrometer allows you to perform a visual verification of the internal fiber optic cable using built-in LEDs, a magnifier placed on the fiber optic bundle matcher, and the Fiber Check software.

**WARNING!** The Fiber Check utility produces rapid flashing lights in the SWIR 1 and 2 region's optical fibers. If you are susceptible to epileptic seizures, exercise caution or avoid using the Fiber Check utility.

**Step 1**  Remove any external fiber optic cable from the spectrometer.

**Step 2**  Remove the bundle matcher. Use the 3/8 inch hex-nut driver to loosen the bundle matcher if necessary.

**Step 3**  Remove the Fiber Optic Port using the 9/16 nut driver (included with the instrument.)

**Step 4**  Carefully insert the tip of the magnifier until it butts up against the internal fiber optic, as shown in Figure 4-7.

**Note:** Be careful not to apply any load or torque to the magnifier which could break the tip off.
Step 5 On the instrument controller, exit any ASD applications that might be running and communicating with the unit. Such applications include RS³ and Indico.

Step 6 Ensure that the spectrometer is turned on.

Step 7 Start the Fiber Check application from the Start menu under All Programs->ASD Programs->RS3 Tools->Fiber Check.

Step 8 Ensure that the IP address configured is the one for the spectrometer.
Step 9  Use the mouse to select the checkbox for the LED to turn on: VNIR, SWIR1, or SWIR2. One or more may be selected at once.

Note: If a range is selected that the spectrometer does not have, that particular LED will not be available to turn on. Nothing will be harmed.

Step 10 Select the **Check** button which turns on the selected LEDs.

Step 11 Look through the magnifier to see which fibers light up.

- Count the number of fibers that show light. Refer to Details about the Fiber Optic Cable and LEDs.

- If applicable, use the checkboxes and the **Check** button shown in Figure 4-8 to turn on and off different LEDs to help determine which range might be affected.

  Note: The RED LED for VNIR may be hard to see when the other ranges are enabled.

![Figure 4-9 Internal spectrometer LED shining to test internal fiber optic cable.](image)

Step 12 When you are finished, shutdown the **Fiber Check** application.

Step 13 Carefully remove the magnifier and re-attach the bundle matcher and fiber optic port using the 9/16 nut driver.

Step 14 Inspect the external fiber optic cable disconnected from the instrument.

1. Unscrew the lens from the magnifier and place it onto the short magnifier assembly
2 Attach the magnifier to one end of the fiber optic cable.

3 Point the other end of the fiber optic cable close to a light.

4 Observe which fibers transmit light.

Details about the Fiber Optic Cable and LEDs

- The LEDs will only turn on for the ranges installed in the spectrometer. Selecting one that the spectrometer does not have will not cause a problem.

- Each range has a different LED color so that you can see the fibers in the cable that are associated with it: RED for VNIR; WHITE for SWIR1; GREEN for SWIR2.

- The fiber bundle of the internal cable contains 19 fibers for the VNIR, and 9 for each SWIR region.

- The fiber bundle of the external cable contains 44 fibers.

- Each broken internal fiber results in an approximate 5% loss of response in that particular range (VNIR, SWIR1, or SWIR2). Each broken external fiber results in a few percentage loss of response over the entire range. It is hard to quantify how a broken fiber in the external cable affects the response of any given range, each time the external cable is connected to the spectrometer, the alignment with the fibers of the internal cable will most likely be different.

The instrument can be successfully used with a few broken fibers in each range, although with a reduction in signal strength.

For severely damaged internal fiber optic cables, send the instrument back to ASD Inc. in its carrying case for repairs. For severely damaged external fiber optic cables, order replacements from ASD Inc.
Notes:
Chapter 5  Batteries

The specifications of the battery are as follows:

<table>
<thead>
<tr>
<th>Type:</th>
<th>Gel Cell Electrolyte</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rating:</td>
<td>12 V 9 amp hour</td>
</tr>
<tr>
<td>Life:</td>
<td>Over four (4) hours using a full-range TerraSpec spectrometer with a Contact Probe in an ambient environment.</td>
</tr>
<tr>
<td></td>
<td>Nine (9) hours using a VNIR-only TerraSpec spectrometer with accessory not powered by the instrument in an ambient environment.</td>
</tr>
<tr>
<td></td>
<td>Recycle batteries and do not dispose of as general waste.</td>
</tr>
</tbody>
</table>

To run the instrument with battery power, plug the battery cable from the battery to the instrument power connector (back of instrument)

Note: How long the spectrometer will run with a fully charged battery depends on many variables including battery age, instrument configuration, environment, and accessories powered by the accessory power port.

5.1 Battery Care

Proper care of the Gel Cell Electrolyte rechargeable batteries ensures a long life.

The batteries are rated to give 200 to 300 uses when they are fully drained (discharged to 9 Volts) each use. Letting the battery discharge under 9 Volts will shorten the battery's life. If the battery is only used for 50% rated capacity up to 500 uses are possible. In the same way using only 30% capacity can result in up to 1,000 uses.

Note: There is no such thing as memory effect on these cells. Only use them for the time needed. After you're finished recharge them fully and then store away till next use.
Recharge a fully discharged battery as soon as possible (usually within 24 hours). Uncharged batteries will be incapable of accepting a charge if the period of time between charges is too long. A partially discharged battery does not need charging immediately. However, prior to storing batteries ensure that they are fully recharged. When 100% charged, these batteries can be stored up to six months, at this time perform a topping charge before use. Always store the battery in a cool, dry location.

WARNING! Do not use batteries other than those supplied by ASD. Do not use ASD batteries in a manner unauthorized by ASD. Using improper batteries or improper use of ASD batteries could result in bodily injury or damage to the instrument.

5.2 Battery Charger

The battery charger specifications:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong></td>
<td>External Desktop</td>
</tr>
<tr>
<td><strong>AC Input:</strong></td>
<td>90-240 VAC, 50/60 Hz</td>
</tr>
<tr>
<td><strong>DC Input:</strong></td>
<td>12 V 1.5 A</td>
</tr>
<tr>
<td><strong>Charge Time:</strong></td>
<td>under 8 hours for a fully discharged 9 AH battery</td>
</tr>
</tbody>
</table>

Review the charger instruction manual for details.

LED Status indicator:

- The LED will be ORANGE during charge.
- The LED will turn GREEN when charge is completed.

The battery charger is designed for indoor use and should not come in contact with water or dust.

Note: Do not unplug the charger and leave the batteries in the charger. Remove the batteries first, or they will discharge through the charger.

Constant overcharging or undercharging will shorten battery life.

Caution! The TerraSpec spectrometer will stop collecting spectra when the battery drains to about 9.7 volts and the software will post a “Spectrometer Isn't Ready” message. However, the instrument and attached probe will continue to draw current if power is left on. Power down the instrument and remove probe as soon as possible when the above message occurs.
5.3 Application Battery Indicator

The RS³ and Indico applications from ASD have a **Power Status**. It is located at the bottom of the main window next to the **Connection Status**. The voltage level of the spectrometer will be reported in the balloon type window.

- 11-12 Volts is considered good (full).
- <11 Volts issues a warning.

![Power Status](image)

Figure 5-1 Example of a **Power Status**
Notes:
Chapter 6  Field Measurements

Spectrometry is the quantitative measurement of reflectance, transmission, or absorption. It involves the collection of accurate spectra and requires an awareness of the influences of:

Accurate and repeatable material analysis or identification requires the accurate and repeatable measurement of reflectance, transmission, or absorption. It requires an awareness of the influences of:

• Sources of illumination.
• Instrument field-of-view.
• Sample viewing and illumination geometry.
• Instrument scanning time.
• Spatial and temporal variability of the sample characteristics.

Many of these parameters are controlled when using one of ASD’s standard sampling interfaces (e.g., MugLite or Contact Probe).

Spectral measurements are desirable for many reasons.

• Spectra of target materials allows for more precise image analysis and interpretation.
• Spectroscopy can perform feasibility studies to understand if and how a process or material of interest can be detected using remote sensing.
• Field spectra can be used to make direct material identifications in the field rather than collecting samples for later laboratory analysis.

The first step in the development of a field experiment is the definition of the overall experimental design. Unfortunately, the formulation of an appropriate experimental design is not always obvious.

Issues such as the timing of the data collection, spatial scale of the field measurement, target viewing and illumination geometry, and the collection of ancillary data sets must be considered in light of the objectives of the study. The lack of appropriate ancillary data sets often makes previously collected data sets unusable for a new application.

Frequently, the experimental design must be modified to account for the characteristics of the available instrumentation.
6.1 Illumination

In order to determine the reflectance or transmittance of a material, two measurements are required:

- The spectral response of a reference sample.
- The spectral response of the target material.

The reflectance or transmittance spectrum is then computed by dividing the spectral response of the target material by that of a reference sample.

Using this method, all parameters which are multiplicative in nature and present in both the spectral response of a reference sample and the target material, are ratio-ed out, such as:

- The spectral irradiance of the illumination source.
- The optical throughput of the field spectrometer.

Note: An inherent assumption when determining the reflectance or transmittance of a material in the field is that the characteristics of the illumination are the same for the reference and target materials. Variability of the illumination characteristics between the time the reference and target materials are measured will result in errors in the resultant spectra.

6.2 Rocks, Soils, and Man-Made Materials

The shape of the spectral signature of rocks and soil tends to be invariant with respect to the viewing geometry. The overall brightness of the observed spectrum does change with illumination and viewing geometry due to changes in the amount of shadow in the field-of-view of the spectrometer.

Absorption features in the spectra of rocks and minerals are due to the presence of specific molecular groups and are often diagnostic of the minerals present in the sample.

6.3 Suggested Set-up

6.3.1 RS3 Application

Step 1 Follow the instructions for plugging in the instrument and starting the RS3 software.

Step 2 Attach an appropriate accessory. Remember that the TerraSpec spectrometer requires an external (artificial) light source.
Step 3  Open the pull down menu **Control -> Adjust Configuration [Alt+C,C]** in the RS³ application.

Step 4  Set the white reference number of scans to 30, and dark current averages to 60 scans.

Step 5  Set the spectrum average (or sample count) to 30 for indoor or artificial illumination.

Note: The actual spectrum average will be determined by striking a compromise between noise reduction through averaging the spectra and the time desired for each spectrum collection. For instance, if you are using the instrument in the field, are walking a large area, and are making frequent spectral readings, you will want a shorter average setting than if you are collecting spectra in-situ and desire the cleanest spectra possible.

Step 6  **Optimize** the instrument to the Spectralon.

Spectralon is an example of a reference standard to take a white reference against. (Labsphere, Inc., Shaker St., PO Box 70, North Sutton, NH 03260-0070, PH: 603-927-4266, FX: 603-927-4694, E-mail: sales@labsphere.com, Website: www.labsphere.com). Spectralon is also available from ASD.

Step 7  Take a **White Reference** (or baseline reference).

Step 8  Observe samples.

### 6.3.2 Indico Application

Step 1  Follow the instructions for plugging in the instrument and starting the Indico software.

Step 2  Attach an appropriate accessory. Remember that the TerraSpec spectrometer requires an external (artificial) light source.

Step 3  Open a new project either by selecting **File->New Project** from the pull-down menu.

Step 4  Type in a name for this project and click on the **OK** button.

Step 5  Select **Spectrum->Sample Count/Average** from the pull-down menu.

Step 6  Set the **Instrument Sample Count** to 30 for indoor or artificial illumination.

Note: The actual spectrum average will be determined by striking a compromise between noise reduction through averaging the spectra and the time desired for each spectrum collection. For instance, if you are using the instrument in the field, are walking a large area, and are making frequent spectral readings, you will want a shorter average setting than if you are collecting spectra in-situ and desire the cleanest spectra possible.
The project screen will return, and the sample count will be displayed in the status box at the bottom of the graph.

Step 7 Make sure the light source is on and the probe input end is pointed at the white reference panel.

Step 8 Select **Spectrum->Take a Baseline [Alt+S, B] [Ctrl+R]**. When prompted, click **Yes, take a new white reference**.

- The TerraSpec spectrometer optimizes the detector sensitivities for the probe and light source currently being used.
- The dark offset and white reference will also be measured and saved.
- Status bars will indicate each process.

When optimization and white reference are complete, you should see a straight baseline across the Project Graph at 1.00 (100%).

Step 9 Select the **Display->Reflectance [Alt+D, R]** for the reflectance mode.

Step 10 Place the sample on the white reference panel and the spacer end in contact against the sample.

This assumes that your reflectance probe has appropriate spacing or spacers on the end.

Step 11 Press the Space Bar once or select the **Spectrum->Take a Scan [Alt+S, T]**.

When the TerraSpec spectrometer finishes recording and averaging the Spectra, the graph in the project window will be updated to show the reflectance spectrum of the sample.

Step 12 Observe samples.

### 6.4 White Reference

A material with 95-99% reflectance across the entire spectrum is called a white **reference panel** or white **reference standard**.

The raw measurement made by the spectrometer is influenced by both the sample and the light source. An independent measure of the light source illumination on a reference of known reflectance is required to calculate the reflectance of the sample. The use of a white reference standard with near 100% reflectance simplifies this calculation.

The ASD application software, such as RS³ and Indico, can calculate the ratios for reflectance or transmittance of the material being sampled by the TerraSpec spectrometer using the white reference as the standard.

Spectralon from Labsphere is the white reference standard that is very suitable for the VNIR and SWIR spectral ranges of ASD instruments.
Spectralon is made of polytetrafluoroethylene (PTFE) and cintered halon. It has the characteristic of being nearly 100% reflective within the wavelength range of 350 nm to 2500 nm. A Spectralon white reference scatters light uniformly in all directions within that wavelength range.

6.4.1 Spectralon Reflectance Data

Table 6-1 shows the published reflectance data for an uncalibrated SRM-990. When SRM-990 is used as the white reference for a reflectance measurement with the TerraSpec spectrometer, an even closer reflectance value for the sample can be calculated.

<table>
<thead>
<tr>
<th>Wavelength (nm)</th>
<th>SRM-990 “Uncalibrated” Spectralon Reflectance</th>
</tr>
</thead>
<tbody>
<tr>
<td>250</td>
<td>0.950</td>
</tr>
<tr>
<td>300</td>
<td>0.985</td>
</tr>
<tr>
<td>400</td>
<td>0.990</td>
</tr>
<tr>
<td>500</td>
<td>0.991</td>
</tr>
<tr>
<td>600</td>
<td>0.992</td>
</tr>
<tr>
<td>700</td>
<td>0.992</td>
</tr>
<tr>
<td>800</td>
<td>0.991</td>
</tr>
<tr>
<td>900</td>
<td>0.991</td>
</tr>
<tr>
<td>1000</td>
<td>0.993</td>
</tr>
<tr>
<td>1100</td>
<td>0.993</td>
</tr>
<tr>
<td>1200</td>
<td>0.992</td>
</tr>
<tr>
<td>1300</td>
<td>0.992</td>
</tr>
<tr>
<td>1400</td>
<td>0.991</td>
</tr>
<tr>
<td>1500</td>
<td>0.991</td>
</tr>
<tr>
<td>1600</td>
<td>0.991</td>
</tr>
<tr>
<td>1700</td>
<td>0.988</td>
</tr>
<tr>
<td>1800</td>
<td>0.989</td>
</tr>
<tr>
<td>1900</td>
<td>0.981</td>
</tr>
<tr>
<td>2000</td>
<td>0.976</td>
</tr>
<tr>
<td>2100</td>
<td>0.953</td>
</tr>
<tr>
<td>2200</td>
<td>0.973</td>
</tr>
</tbody>
</table>
6.4.2 Maintaining Spectralon References

Spectralon is an optical standard and should be handled in much the same way as other optical standards. Although the material is very durable, care should be taken to prevent contaminants such as finger oils from contacting the material’s surface. Always wear clean gloves when handling Spectralon.

**To clean a lightly soiled Spectralon white reference**

If the material is lightly soiled, it may be air brushed with a jet of clean dry air or nitrogen.

**WARNING! DO NOT use Freon.**

**To clean a heavily soiled Spectralon white reference**

Sand the Spectralon material under running water with a 220-240 grit waterproof emery cloth or sandpaper until the surface is totally hydrophobic (water beads and runs off immediately).

- **Step 1** Use a flat surface, such as a thick, flat piece of glass.
- **Step 2** Place the glass into the sink.
- **Step 3** Place 220 grade wet sandpaper onto the glass.
- **Step 4** Gently move the Spectralon reference in a figure 8 motion on the sandpaper, using water as needed to wash away the thin layer that is sanded off.
- **Step 5** Blow dry with clean air or nitrogen or allow the material to air dry.
- **Step 6** If the material requires high resistance to deep UV radiation, the piece should be prepared as above, then either of the following two treatments performed.
  1. Flush the Spectralon piece with >18 milli-ohm distilled, deionized water for 24 hours.

---

Table 6-1 Labsphere's published reflectance data for uncalibrated Spectralon (+/- 0.5%)

<table>
<thead>
<tr>
<th>Wavelength (nm)</th>
<th>SRM-990 “Uncalibrated” Spectralon Reflectance</th>
</tr>
</thead>
<tbody>
<tr>
<td>2300</td>
<td>0.972</td>
</tr>
<tr>
<td>2400</td>
<td>0.955</td>
</tr>
<tr>
<td>2500</td>
<td>0.950</td>
</tr>
</tbody>
</table>

Reflectance = Energy reflected from target/energy incident on target
2. Vacuum bake the Spectralon piece at 75° C for a 12 hour period at a vacuum of 1 Torr or less. Then purge the vacuum oven with clean dry air or nitrogen.

**WARNING!** Do not use oils or soaps to clean the Spectralon white reference.

### 6.4.3 White Reference Procedures

Baseline references, or white references, should be collected approximately every 15 minutes while the instrument is warming up; thereafter, every hour or so is sufficient. The Spectralon puck should be used when optimizing and taking a white reference measurement.

The TerraSpec spectrometer should be re-optimized for:

- Light changes.
- Temperature changes.
- Whenever accessory probes are changed.

**Note:** Environmental conditions can change rapidly or slowly. It all depends on clouds, wind (affecting temperature), instrument warm up time, etc.
Notes:
Appendix A Troubleshooting

A.1 Common Communication Fixes

To fix many communication errors (particularly if the instrument has been functioning at some point), power cycle the instrument and/or the instrument controller.

The sequence to use will vary depending on the computer manufacturer. Either:

• Leave the computer on. Turn off the instrument. Wait for 10 seconds. Turn the instrument back on.
• Or, turn off the computer and the instrument. Turn on the instrument. Then turn on the instrument controller.

For the best performance, you should assure a clear line-of-sight between the spectrometer and instrument controller. Obstructions or radio frequency interference in close proximity can cause loss of communication or significantly shorten the communication range.

The TerraSpec spectrometer uses industry standard components. You should see the same general connection speed and distance capabilities as other wireless devices.

A.2 Does Not Connect to the Spectrometer

• Refer to section A.1, Common Communication Fixes.
• Check that the Ethernet cable is securely inserted into the spectrometer and host computer. Check that the Ethernet LED is on.
• For an isolated network, check that the Ethernet cable is a cross-over Ethernet cable.
• For an established network, check that the Ethernet cable is a standard Ethernet cable.
• Check that the IP Address is in the same range or subnet as the ASD spectrometer. The same subnet means that the first three octets of the IP address (xxx.xxx.xxx.___) match the spectrometer and the computer.
• Do a ping test to make sure the spectrometer is responding.
  » Open up a command window by select Start->Run
  » Type cmd in the Run window.
  » Select OK to open the window.
  » For an Ethernet connection, type: ping 10.1.1.11
  » For a wireless connection, type: ping 10.1.1.77

The default IP Address for the ASD spectrometer is:
• 10.1.1.11 for the Ethernet interface, or
• 10.1.1.77 for the wireless interface.
The default subnet mask is 255.255.255.0.

The computer's Ethernet adapter or wireless adapter must have a unique IP address in the same range as the spectrometer, such as 10.1.1.x where \( x \) is a unique number. The subnet mask must also be the same as the spectrometer, such as 255.255.255.0.

### A.3 Does Not Connect Wireless

- Refer to section A.1, *Common Communication Fixes*.
- Check to make sure the wireless adapter is in the same range as the ASD spectrometer.
  
The default IP Address for the ASD spectrometer is:
  
  » 10.1.1.11 for the Ethernet interface, or
  
  » 10.1.1.77 for the wireless interface.

  The default subnet mask is 255.255.255.0.

  The computer's Ethernet adapter or wireless adapter must have a unique IP address in the same range as the spectrometer, such as 10.1.1.x where \( x \) is a unique number. The subnet mask must also be the same as the spectrometer, such as 255.255.255.0.

- Check to make sure the wireless adapter is connected to the spectrometer.
  
  *(For Windows XP)*

  » Select **Start->Network Connections**.

  » Right click on the wireless adapter.

  » Select **View Available Wireless Networks**.

  » Make sure the ASD spectrometer shows up in the list of wireless networks. If the spectrometer is not connected,

  » Select the spectrometer.

  » Select the **Connect** button.

  » If you are using encryption, then make sure you are using the same WEP key in the wireless adapter as the ASD spectrometer.

  » Power cycle the spectrometer.
A.4 Does Not Connect to the Access Point

- Refer to section A.1, Common Communication Fixes.
- Check to make sure the wireless interface on the spectrometer is not set to **ad hoc**.
- Check to make sure the **SSID** of the spectrometer is the same as the access point.
- If you are using encryption, then make sure you are using the same **WEP** key in the spectrometer as the access point.
- Move the access point, spectrometer, and instrument controller (computer) to the same room to test the connection.
A.5 Spectrometer Loses its Wireless Connection

- Refer to section A.1, Common Communication Fixes.
- Try to minimize the RF noise in your environment. RF noise interference can come from: 2.4 Ghz cordless phones, microwaves, monitors, electric motors, ceiling fan, lights, security systems, etc.
- Positioning of the spectrometer and instrument controller (computer) can affect the wireless range. Minimize obstructions between the spectrometer and the instrument controller. Wall, ceilings, doors, buildings, hills, etc. can degrade the signal of the spectrometer and computer.

A.6 Wireless Interface is Disabled in the Netcfg Application

- Refer to section A.1, Common Communication Fixes.
- Check to make sure the wireless adapter is in the same range as the spectrometer.

  The default IP Address for the ASD spectrometer is:

  » 10.1.1.11 for the Ethernet interface, or
  » 10.1.1.77 for the wireless interface.

  The default subnet mask is 255.255.255.0.

  The computer's Ethernet adapter or wireless adapter must have a unique IP address in the same range as the spectrometer, such as 10.1.1.x where x is a unique number. The subnet mask must also be the same as the spectrometer, such as 255.255.255.0.

- Unplug the Ethernet cable from the spectrometer.
Appendix B Reference Information

B.1 Frequently Asked Questions (FAQ)

B.1.1 What is a spectrometer?

*Spectrograph* - An optical instrument for forming the spectrum of a light source and recording it on a film. The dispersing medium may be a prism or a diffraction grating. This term was common prior to the digital age. ASD instruments do not use film.

*Spectrometer* - An optical instrument which uses detectors other than photographic film to measure the distribution of radiation in a particular wavelength region. All ASD instruments are spectrometers.

*Spectroradiometer* - An optical instrument for measuring the radiant energy (radiance or irradiance) from a source at each wavelength throughout the spectrum. A spectroradiometer is a special kind of spectrometer.

Note: Only the FieldSpec spectrometer is configured as a spectroradiometer. The reason is that the fiber optic cable significantly affects the calibration required to measure radiance. The FieldSpec instrument has a fixed fiber optic cable routed directly through the front panel to the internal spectrometers, while the other ASD spectrometers are designed to detach and even interchange fiber optic cables. To be meaningful, radiance measurements with non-FieldSpec instruments would have to be performed using the same fiber optic cable and the same connector orientation of the plugged in fiber optic cable as the factory calibration.

The SWIR component of the ASD spectrometer is a *scanning spectrometer*, while the VNIR component is an *array spectrometer*. 
B.1.2 What are the differences between the ASD spectrometers?

*FieldSpec* - is a general-purpose spectrometer specifically designed for field environmental remote sensing. The FieldSpec is a spectroradiometer in that it is calibrated to be able to perform radiance and irradiance measurements, as well as reflectance and transmittance. The fiber optic cable is routed through the front panel and is fixed to the internal spectrometers, which provides a superior signal-to-noise ratio than the other ASD spectrometers with detachable fiber optic cables. (The FieldSpec spectrometer can also be specially ordered as a high-resolution instrument, the main TerraSpec feature.)

*TerraSpec* - is a high-resolution spectrometer specially designed for mining and geology applications. It is ideally suited for performing reflectance spectral measurements of rocks, minerals, and core samples. Its higher resolution is optimized for samples that have high absorption features. The Hi-Brite MugLite and Hi-Brite Contact Probe are designed to work with this spectrometer.

*AgriSpec* - is a general-purpose spectrometer designed for agriculture and the field analysis of vegetation and soils. Its resolution is ideally suited for performing reflectance and transmittance spectral measurements of samples that have broad absorptions features. This spectrometer can use nearly all of the accessories containing a light source, such as the plant probe and leaf clip.

*LabSpec* - is a general-purpose spectrometer designed not only for laboratory analysis, but also for the plant floor, receiving, and even field work. It is meant to be portable for multiple uses requiring visible and near infrared reflectance, transmission, or absorbance to analyze and identify materials. The LabSpec is similar to the AgriSpec. The LabSpec 2500 has a 10 nm resolution, while the LabSpec 2600 has a 6 nm resolution.

*QualitySpec* - is a general-purpose spectrometer specifically designed for material analysis and identification in the laboratory. The QualitySpec features are equivalent to the AgriSpec except that it is not field-portable.

B.1.3 What is remote sensing?

*Remote sensing* is defined as the art and science of obtaining information about an object without being in direct physical contact with the object.

The ASD spectrometers achieve this using visible near-infrared (VNIR) and short-wave infrared (SWIR) spectra.
B.1.4 How often do I need to optimize?

Optimization has no affect on the data unless the measurement has drifted towards saturation, in which case optimization is mandatory. The RS³ application provides a saturation warning.

B.1.5 How often do I need a (baseline) White Reference?

Inside Use or Constant Lighting Conditions

When using the instrument inside under constant lighting conditions or when using an accessory with its own light source, collect a (baseline) white reference every 10 to 15 minutes while the instrument is warming up and then every hour or so thereafter.

Outside Use

When using the instrument outside, you should collect a new white reference frequently for:

- temperature changes
- accessory changes (like switching probes)

It is important that the light intensity is the same for when the white reference is collected as for the measurements of the sample.

B.1.6 What spectrum average (or sample count) should I use?

When used with the Hi-Bright MugLite or Contact Probe, it is usually sufficient to use 30 scans in the spectrum averaging for the sample and 60 scans for the white reference. The white reference isn’t taken as often, which is why you would want to include more scans in its averaging.

The signal-to-noise measurement increases with the square root of the number of scans used in the averaging.

Note: The actual spectrum average will be a compromise between noise reduction through spectra averaging and the time required for each spectra collection. For instance, if you are using the instrument in the field to measure a large number of samples, you will want a smaller number of spectra in the average to decrease the collection time required. If you are collecting spectra in the lab, you’ll want to increase the number of spectra in the averaging to obtain the cleanest spectra possible.

B.1.7 What if I want to keep the same settings all day?

Even if you could keep the same settings for the integration time, gain value, and offset value for the entire day, you probably wouldn’t want to.
Most of the measurements made by the instrument are ratios where such values get cancelled out and become irrelevant.

It is far more important to keep the instrument from saturation and to ensure the (baseline) white reference is fresh.

**B.1.8 What are the units of radiance?**

Radiance is the radiant power per unit source area per unit solid angle. This is measured in Watts per square meter per steradian (W/m²/sr).

The TerraSpec spectrometer does not measure radiance, because this requires radiometric calibration files which are dependent on the fiber optic cable and its connection to the instrument. (The TerraSpec spectrometer can be used with different accessories and fiber optic cables.)

The TerraSpec spectrometer measures only reflectance and transmission measurements.

**B.1.9 Can I post-process my data?**

Yes. ViewSpec is one of many applications that can post-process your data. Various software packages are available for chemometric model. The spectral data can be imported into many different applications.

The complete specification of the ASD file format is available upon request.

**B.1.10 Why do I see oscillations (sine wave) in my data?**

Your light source may use AC power. A single SWIR band is about 100 ms. If you observe five (5) or six (6) waves in a single SWIR, the AC light source is the cause.

Waves can also occur if the lamp reflector and/or cover glass behave as a white-light interferometer. Solution: remove the glass and/or use a more diffuse reflector.

**B.1.11 What are these upward or downward spikes in VNIR data?**

These result from artificial light sources, in particular fluorescent lights.
B.1.12 What are these steps in my data?

Light is brought into the instrument by various combinations of the strands in the fiber optic cable. Each strand has its own field-of-view (FOV). When the cable is held close to the sample, each strand views slightly different portions of the sample. This can result in the stepped data.

Stepping of data is common when the foreoptic has a lens, and less common when using the bare optics or sampling devices.

B.1.13 What can cause more noise in my data from last time?

Many factors can cause noise in your data from one session to another. Noise in a measurement is related to the instrument, the signal level, and noise in the light source. Many times the appearance of noise is actually a decrease in the strength of the signal, as opposed to an increase in noise.

Under normal operating conditions, noise visible in a spectrum is always the result of a trade-off between the inherent noise in the system and the signal.

Check how the external fiber optic cable is aligned with the internal cable for changes in signal through-put.

Figure B-1 Spectrum of fluorescent lights
Also, broken fibers in the fiber optic cable can contribute to noise. Perform a fiber optic check to verify.

An increase in noise can be due to a problem in the instrument such as an electronic component malfunction or a grounding problem. This will many times be indicated by a regular pattern to the noise or periodic bursts of noise that are visible over the normal spectra.

**B.1.14 Why does the VNIR drop to zero after a Dark Current collection?**

When the VNIR drops to zero after a Dark Current has been collected, this may indicate a problem with the VNIR shutter or Dark Current collection routine. To verify, optimize the instrument and listen for the click of the shutter activating. If you do not hear the shutter click, contact technical support and obtain an RMA for sending the instrument in for repairs.

**B.1.15 How do I set up GPS?**

The GPS feature is enabled in the RS³ application software.

**To configure the GPS:**

**Step 1** Select either:
- **GPS->Settings...** pull-down menu item.
- **Alt+G, S** key combination.

RS³ requires the output of the GPS device to be in the National Marine Electronics Association (NMEA) format. Check your GPS device documentation for output and port settings.

Normally, the Baud rate (4800), Data bits (8), Parity (none), and Stop bits (1) settings will remain the same as what is displayed in the window. The **Write to log file** is checked by default. When this field is checked and the GPS fixed data is enabled, an entry will be made to a daily log file (i.e. 050302gps.log) when a spectrum is saved.

**Step 2** In the **GPS Settings** dialog box, enter communication settings appropriate for your instrument controller’s port intended for use as well as the GPS device.

**Note:** The RS³ settings on the instrument controller and the ports that are used must match the actual port used as well as the settings of the GPS device.

**Step 3** Connect an appropriate cable between the instrument controller’s port and the GPS device.

You may need a serial-USB converter depending upon the instrument controller and GPS device.
Step 4  Enable the GPS functionality in the RS³ application by selecting either:
- **GPS->Enable...** pull-down menu item.
- **Alt+G, E** key combination.

Step 5  Refer to the manual of your actual GPS device for further instructions regarding usage and configuration.

### B.1.16 What does a broken fiber mean?

The internal fiber-optic cable is made up of fifty-seven (57) randomly distributed glass fibers.
- 19 fibers are 100 micron for the VNIR region.
- 19 fibers are 200 micron for the SWIR1 region.
- 19 fibers are 200 micron for the SWIR2 region.
Therefore, a single broken fiber in the internal cable results in a ~5% reduction in the signal in a given region.

The external fiber-optic cable is made up of forty (44) 200 micron glass fibers.

Note: Each broken external fiber results in a few percentage loss of response over the entire range. It is hard to quantify how this affects the response of any given range, because each time the external cable is connected to the spectrometer, its alignment with the fibers of the internal cable will most likely be different.

A few broken fibers is not critical when measuring reflectance, because this is a ratio. Any noise introduced by the broken fibers in measuring the sample were also present when measuring the white reference, and therefore cancels out.

The fibers are protected by a metal spiral inside the black cable casing. If there are kinks in your cable, the fibers are not necessarily damaged. However, if your cable has been crunched so severely that you are able to see the protective metal spiral, the chances are high that the fibers have been damaged too. Refer to the Fiber Optic Check utility to determine if any fibers are broken.

The fibers can be damaged by coiling the cable up too tightly. If left in a tight coil for longer than a week, the fibers are likely to develop longitudinal fractures that will not be detectable. These fractures in the fiber will cause light leakage, resulting in a weaker signal. The fiber optic cables should be stored by placing them loosely within the netting compartment on the instrument.

**WARNING!** The fiber cable should never be stored with a bend of less than a 5" diameter for long periods of time.
B.1.17 How long is the battery life?

The charge of the NiMH (Nickel-Metal Hydride) battery lasts about nine (9) hours using a VNIR-only spectrometer with accessory not powered by the instrument in an ambient environment. The charge of the NiMH battery lasts over four (4) hours using a full-range spectrometer with a Contact Probe in an ambient environment.

The Gel Cell rechargeable battery lasts about nine (9) hours using a VNIR-only spectrometer with accessory not powered by the instrument in an ambient environment. The charge of the Gel Cell battery lasts over four (4) hours using a full-range spectrometer with a Contact Probe in an ambient environment.

The Gel Cell rechargeable batteries are rated to give 200 to 300 uses when they are fully drained (discharged to 9 volts) each use. Letting the battery discharge under 9 Volts will shorten the battery’s life. If the battery is only used for 50% rated capacity up to 500 uses are possible. In the same way using only 30% capacity can result in up to 1,000 uses.

Note: The limiting factor for how long you can work in the field may be the battery in the instrument controller rather than the spectrometer’s batteries.

B.1.18 What type of Ethernet cable can I use for the static IP configuration?

The spectrometer can be plugged directly into the instrument controller using a cross-over, shielded Ethernet cable.

When the spectrometer and instrument controller communicate over a network, use standard shielded Ethernet cables and IP addresses compatible with the network. The spectrometer imposes significant traffic on the network, which can cause packet delays to other users. More importantly, network traffic from other users can negatively impact the reliability of the communication between spectrometer and instrument controller.

B.1.19 Can I install additional software on the instrument controller?

Yes, but with qualifications.

The types of applications that can interfere with the measurement of data are utility programs, network programs, and those working in the background, such as virus checkers.

ASD programs, such as RS³ and Indico, require real-time access to the data that is being streamed from the TerraSpec spectrometer at a high rate of speed. Programs running in the background can cause packets to be lost.
Microsoft Office, image processing programs, and other software applications generally do not interfere with ASD programs, particularly if they are not running and competing for CPU cycles and RAM at the same time that data is being collected from the TerraSpec spectrometer.

**B.1.20 Why does the software seem to do unexpected things?**

To assure accuracy in the collection and processing of data, the ASD application software is designed to finish its current operation before moving on. The TerraSpec spectrometer outputs a lot of data at a high rate of speed for the ASD application software to collect.

In addition, the ASD application software will stack up your keystroke entries and execute them later in the order they were received.

It is important that you wait for the collection to finish before entering the commands to launch another operation. Don’t rush into new operations or into issuing new commands until you see the results of the current command.

**B.1.21 How long does it take for the TerraSpec spectrometer to warm up?**

The warm-up time of the instrument depends on the environment in which it is used.

Only 15 minutes is needed for reflectance measurements, particularly if conserving battery life is desirable.

**B.1.22 Where is my serial number?**

The serial number is a five (5) digit number located on a label on the rear of the TerraSpec spectrometer where the power switch is. The label also contains the model number and MAC address for the spectrometer.

![Label with serial number.](image)
The serial number is also accessible in the RS\(^3\) and Indico applications from the splash screen or the Help->About menu item.

### B.2 Data Conversion

When using the RS\(^3\) application, ViewSpec can convert spectral data to ASCII text files.

Conversion can be done one file at a time. Or, several files can be merged into a single text file, which is a useful feature when inputting data into other analysis programs.

### B.3 Gain and Offset

Gains and offsets are determined during optimization by an optimization algorithm in the RS\(^3\) application. You can observe this process in the RS\(^3\) application by depressing the OP button on the top right-hand toolbar. The gains, offsets, and integration time will then appear in the lower left hand corner. These parameters are set by the optimization routine and cannot be set manually.

The **Gain Value** is the inverse of actual gain. A decrease in **Gain Value** will produce a higher gain. The maximum **Gain Value** is 16. Under the low light levels that create such a gain, small changes in **Offset** will translate into large changes in dynamic range.

**Offset** causes a downward shift (from \(Y=32,768\) DN) in a SWIR spectrum such that the max value of the spectrum and the minimum value of the spectrum (Dark Current - off screen) are equidistant from the line \(y=32,768\). Under ideal conditions, where there's enough light, there will be about 32,768 DN of signal immediately after optimization, +/- 1,000. This means that optimization “creates” about 16,000 DN of dark current and about 16,000 DN of dynamic range. But this dynamic range will disappear with either a slight increase in signal (if the signal started out low to begin with) or a slight increase in dark current (increases with ambient temperature).

### B.4 Optimization

The TerraSpec spectrometer must be re-optimized for:

- Every 30 minutes when used with ASD’s Hi-Bright MugLite or contact probe.
- Changes in temperature.
Optimization depends on the response to light in a particular spectral region. A well-optimized instrument will display between 20,000 and 35,000 raw digital numbers, if the source is within the gain and integration time abilities of the system. The magnitude of the VNIR raw DN will be directly dependent on the light intensity.

The Spectralon blank should be used when optimizing and for taking a white reference measurement.

Note: It is important that the position of the reference sample when taking a white reference is as similar as possible to the position for capturing data from the samples.

### B.5 Spectrum Averaging (or Sample Count)

If signal levels are low, the only way to increase S/N is by reducing noise through spectrum averaging. However, spectrum averaging takes more time per spectrum.

### B.6 Temperature Effects

The TerraSpec spectrometer instruments have thermo-electrically cooled SWIR detectors (to -25 C), significantly reducing noise in those areas.

When the system fails due to extreme temperature, it will fail gradually but the data won’t make perfect sense. Shut down and let the instrument cool before operating again.

You may also see the TerraSpec spectrometer saturate in the SWIR 2 region if the instrument is still coming to equilibrium from a cooler environment to a warmer environment. Frequent re-optimizations will address this problem until the instrument comes to equilibrium.

The ASD applications provide a warning when the SWIR detectors are out of thermal regulation.

### B.7 Technical Support

If you have any questions or concerns, please contact ASD Inc. by phone, fax, or email:

Phone: 303-444-6522 X-144
Fax: 303-444-6825
e-mail: support@asdi.com
Web: www.asdi.com
ftp: ftp.asdi.com
Technical support is committed to providing you with a timely response to your questions. We will work with you to provide solutions to your applications. Technical support is available to answer your questions Monday thru Friday, 8 am to 5 pm Mountain Standard Time. We will happily respond to your e-mail queries as well.

B.8 W.E.E.E. Compliance

Analytical Spectral Devices supports the W.E.E.E. Regulation. ASD marks the instruments with the symbol at the left to show that this product has entered the market place after August 13, 2005.

If you decide to end the use of the spectrometer, please do not discard as general waste. ASD will accept the return of your instrument for recycling purposes. Contact ASD Customer Service to arrange for the return of your instrument.
Index

A
access point
can’t connect 46
accessories 4
accessory
  light sources and probes 9
accessory power port 16
AgriSpec 50
array spectrometer 49
ASCII conversion 58

B
baseline collection 51
battery 31
care 31
battery life 56
broken fiber 55

C
check fiber optic cables 26
cleaning 20
communications 7
computer requirement 5
conversion of data 58

D
dark current in VNIR 54
Dark Current measurement 8
data conversion 58
data sinusoidal wave 52

E
Ethernet 15
Ethernet cable 56
Ethernet interface 4

F
fiber check 26
fiber optic cables 21
fiber optics 21
fiberoptic interface 21
field-of-view 53
FieldSpec 50
Frequently Asked Questions (FAQ) 49

G
gain 58
GPS 54

H
hardware specifications 2

I
illumination 36
instrument controller 5
interface requirement 4

L
LabSpec 50
language settings, Windows 5
LED fiber optic check 26
light sources 19

M
maintenance
  annual 20
materials
  man-made 36

N
near infrared 7
Netcfg 47
NIR 7
noise in data 53

O
offset 58
optimization 51, 58

P
physical specification 2
post-process data 52
power port
  accessory 16
power requirements 2
power supply 13

Q
QualitySpec 50
R
radiance units 52
remote sensing 50
return merchandise authorization 20
RMA 20
rocks 36

S
sample count 51
scanning spectrometer 49
serial number 57
short-wave infrared 7
software requirement 5
software, additional 56
soils 36
spectrograph 49
spectrometer 49
does not connect 43
twoy of operation 6
spectroradiometer 49
spectrum averaging 59
spectrum average 51
steps in data 53
support ii
SWIR 7

T
technical support ii
temperature effects 59
TerraSpec 50
trademarks ii
trigger 17

U
units of radiance 52

V
ventilation 19
visible/near-infrared 6
VNIR 6
VNIR dark current 54
VNIR spikes 52

W
warm up 57
wavelength specification 3
white reference 8, 38, 51
Windows language settings 5
wireless connection
can’t get 45
loses 47
wireless interface
disabled 47